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System Requirements

Chapter 1. Getting
Started

Genosys is a MacOS application. Below are the system
requirements:

Genosys is a music composition application for the
Genos, Yamaha’s flagship workstation keyboard. Use
Genosys to compose full song arrangements that are
played back on the Genos keyboard.

•

Yamaha Genos keyboard *

•

MacOS 10.10.5 (Yosemite) or higher

•

1500 X 1200 pixel or higher screen resolution

Genosys songs comprise a series of MIDI events which
play back sequentially, according to each event’s
bar:beat position. Event types include:

•

USB 2.0 Type A male to Type B male cable (to
connect the Mac and Genos)

•

USB flash drive (to transfer the "Genosys
MIDI.msu" setup file to the Genos)

•

style commands
e.g., Intro 1, Main B, Fill Self, Break, OTS 2

•

style chord progressions
e.g., C3 E3 G3 -> F3 A3 C4 -> G3 B3 D4

* When a Genos keyboard is not connected, Genosys can still be
used to compose songs in offline mode. However, no sound will
be output.

•

multi pad control
e.g., Multi Pad 4, Multi Pad Stop

Hardware Setup

•

notes
e.g., Note R1 | C3 | 100 | 000:1:00

1. Connect the square end of the USB cord to the
USB port on the rear of the Genos.

•

and more...

2. Connect the rectangular end of the USB cord to a
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USB port on the computer.

option.
7. Choose the "Factory Reset/Backup" option and
navigate to page 2.

Genos Setup

8. Optionally, back up the Genos' current MIDI
settings by choosing the "Save" option on the
"MIDI" row.

In order for Genosys to communicate with the Genos,
the "Genosys MIDI.msu" file (located in the Genosys
application folder) must be transferred to the Genos:

9. Choose the "Load" option on the "MIDI" row.

1. Format a USB flash drive on the Genos. (Refer to
page 112 of the Genos Owner's Manual for
instructions.)

10. At the top of the screen which appears, choose
the "User" option and then the "USB1" option on
the left-hand side.

2. Remove the USB flash drive from the Genos and
insert it into a USB port on the computer.

11. Choose the "Genosys MIDI" option. An alert
dialog appears. Choose "Yes" to load the
Genosys MIDI file.

3. Copy the "Genosys MIDI.msu" file (located in the
Genosys application folder) to the USB flash
drive.

12. On the Genos front panel, press the "Menu"
button.

4. Insert the USB flash drive into the USB port on
the front panel of the Genos. Wait a few seconds
for the USB flash drive to mount.

13. Navigate to "Menu2" and choose the "MIDI"
option.

5. On the Genos front panel, press the "Menu"
button.

14. Touch the blank box at the top of the "MIDI"
screen.

6. Navigate to "Menu2" and choose the "Utility"
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15. At the top of the screen which appears, choose
the "User" option.

"Genos: Not Connected."

Demo Mode

16. Press the "Genosys MIDI" button.
17. On the Genos front panel, press the "Home"
button.

Genosys is distributed to unregistered users as a demo
application.

The Genos is now set up for MIDI communication with
Genosys.

In demo mode, Genosys plays back songs that are up
to 25 bars long. All other Genosys features are
otherwise fully functional.

Launching Genosys

Registering Genosys

1. Turn on the Genos keyboard and wait for it to
power up.

1. Launch the Genosys application.

2. Launch the Genosys application on your
computer.

2. Choose "About Genosys..." from the "Genosys"
menu.

3. At the bottom right of the Genosys window, note
the "Genos: Connected" indicator. This indicates
that the Genos is in MIDI communication with the
Genosys application.

3. In the window which opens, click on the
"Register..." button.
4. As prompted, enter the requested information.

If the Genos is turned off or the USB cord is not
connected, the indicator will instead read
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Playing the Demo Song

highlighted in the Event List (top-left of the
window) and Timeline (bottom of the window).

1. Turn on the Genos keyboard.

Sequences

2. Using the Genos touchscreen, choose the
"UnpluggedPop" style which is located on page
2 of the "Pop" styles.

In Genosys, a list of events is referred to as a sequence.
The Event List lists the events in the currently active
sequence.

3. On the Genos front panel, press the "Home"
button.

Sequence Types

4. On the Genos front panel, enable the "ACMP"
and "Auto Fill In" buttons. Disable the "OTS Link"
button.

There are two types of sequences. The main "Song"
sequence is the top-level sequence of a song. The
"Song" sequence can play back MIDI events. It can also
play back other sequences which are inserted into the
"Song" sequence.

5. Launch the Genosys application on your
computer.
6. Choose "Open..." from the "File" menu to open
the "Demo Song (Unregistered).gen" file which is
located in the Genosys application folder. (If you
have purchased a license for Genosys and
registered the software, you can instead open
the "Demo Song (Registered).gen" file.)

Other sequences that you create can play back MIDI
events, but they cannot play back other sequences.
Only the top level "Song" sequence can have other
sequences inserted into it.
To switch between the sequences you have created,
click on the “Sequence:” display.

7. In Genosys, press the Play button to play the
song. As each event is played back, it is
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Creating, Renaming, and Deleting
Sequences
To create, rename, or delete a sequence, click on the
“Sequence:” display and choose an option from the
pop-up menu which opens.
The events in a sequence can be copied and moved to
other sequences. Choose options from the "Edit" menu
to cut, copy, and paste the selected events in the Event
List from one sequence to another. To select events that
are not adjacent to one another, hold down the
Command key and click on the events to select.
Genosys songs are automatically saved as they are
being composed. However, it is strongly recommended
that songs be periodically backed up. Choose “Backup
Song…” from the “File” menu.
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Chapter 2. User
Interface
Genosys is a single window application. Most of the
software's features can be accessed via this window.
The window includes six panes (see Figure 1):
1. Transport
2. Event List
3. Timeline
4. Recorder
5. Keyboard Console
6. Style Console

Figure 1: The Genosys user interface.
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Transport

again to disable step recording.

Use the Transport to navigate the current sequence.

Locator

Press the Rewind button to go to the beginning of the
sequence.

To the right of the Transport, is the Locator which
displays the current time position in the sequence. Click
on the up and down arrows beside the Locator to
change the current time position by division
increments. Hold down the Option key to change the
current time position by bar increments.

Press the Previous Marker button to go to the previous
marker in the sequence. For example, a marker can be
used to mark and recall the beginning location of a
verse or chorus in a song.

In Genosys, time positions are formatted as follows:

Press the Play button to begin playing the sequence
from the current time position. Press the Play button
again to stop playback.

Bar:Beat:Division
Bar: Ranges from 000 to 999
Beat: Ranges from 1 to 4 (i.e., 4/4 time1)
Division: Ranges from 01 to 04

During playback, interacting with the Genosys user
interface can cause playback timing issues to occur.
Always stop playback before making changes to a
sequence.

For example:
000:1:01
050:3:02
199:4:03

Press the Next Marker button to go to the next marker
in the sequence.
Press the Record button to step record, inserting notes,
chords, and style commands using the Keyboard
Console and Style Console. Press the Record button

1
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Time

The last example above is bar 199, beat 4 of 4, and
division 03 of 04.

The current Time position of the song in
minutes:seconds is displayed below the Locator.

Each beat is sub-divided into four divisions. Therefore,
each division has a 16th note value (i.e., 4 X 16th note =
1 beat).

Metronome

Tempo

A note on the Genos can be set to play a Metronome
sound during playback. The metronome sounds at a
louder velocity on beat 1 and at a softer velocity on
beats 2, 3, and 4.

Below the Locator is the Tempo indicator. Click on the
Tempo indicator to select a different tempo.
Genosys supports the following tempos2: 40, 50, 60, 75,
100, 120, 150, and 200 beats per minute (BPM).

Click on the Tempo indicator to turn on the
metronome. Also click on the Tempo indicator to set
the MIDI channel and note for the metronome sound
using the Keyboard Console.

Should you wish to record a song at a tempo that is not
supported by Genosys, compose the song using the
closest available tempo. Then capture the song on the
Genos keyboard, using the Genos' multitrack MIDI
recording function (refer to the Genos Reference
Manual). The tempo of the recorded MIDI song can
then be changed on the Genos.

Event List
The Event List lists the individual events in the current
sequence ordered by time. During playback, the Event
List scrolls through the events, highlighting each as it is
played back.

2

The eight supported tempos are aligned with Genosys's internal
timing functionality, allowing Genosys to remain in sync with the
Genos keyboard during song playback.

When the Record button on the Transport is enabled,
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events can be inserted into the Event List using the
Keyboard Console and Style Console.

Refer to Chapter 4 for more details about the Keyboard
Console, including how to use the Keyboard Console to
insert style chord progressions.

In the Event List, right-click on the column of an event to
edit it, as well as any other events that are selected.

Offset

Refer to Chapter 3 for more details about the Event List,
including how to use the Event List to filter events.

Above the Style Console is the Offset indicator. Click on
the up and down arrows beside this indicator to set the
time position gap between inserted events. (Optionclick to change the value by bar increments.)

Style Console

When an event is inserted into the sequence, the
current position is moved forward by the Offset value.

When the Record button on the Transport is enabled,
click on a Style Console button to insert a style event
into the sequence at the current time position.

For example, if the current position is 005:1:01 and the
offset is 002:0:00, after the next event is inserted, the
current position will move forward two bars to 007:1:01.

Refer to Chapter 4 for more details about the Style
Console, including how to use the Style Console to turn
style channels on and off using volume events.

Length

Keyboard Console

To the right of the Offset indicator is the Length
indicator. Click on the up and down arrows beside this
indicator to set the length of inserted note events.
(Option-click to change the value by bar increments.)

When the Record button on the Transport is enabled,
click on a Keyboard Console key to insert a note event
into the sequence at the current time position.
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Memory

Recorder

To the left of the Offset indicator are five Memory
buttons. To store the current offset and length values
for instant recall later, hold down the Option key and
click on a Memory button.

Use the Recorder to record the notes you play on the
Genos into Genosys. To capture a live recording:
1. On the Genos, enable/disable the L, R1, R2,
and/or R3 voices as desired. Only the enabled
voices will be captured.

To recall a saved offset and length, click on a Memory
button.

2. In Genosys, set the Event List to the sequence to
play back whilst capturing your Genos
performance. (For no accompaniment, create a
new empty sequence.)

Similar to other Genosys preferences, Memory settings
are saved with the current song.

Timeline

3. In Genosys, set the Locator to the start position
for the recording.

The Timeline visually arranges the marker, style
command, style chord, and multi pad events in the
current sequence running left to right along a timeline.
During playback, the Timeline scrolls through the
events in the current sequence, highlighting the current
bar.

4. In Genosys, optionally turn on the metronome by
clicking on the Tempo Indicator.
5. In the Recorder, enable the Power button (to the
right of the "Recorder:" label) to begin capturing
your Genos performance.

Refer to Chapter 5 for more details about the Timeline,
including how to use the Timeline to assign sequences
to different sequence layers.

6. In Genosys, click on the Transport’s Play button
to begin playback.
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7. On the Genos, begin playing your performance
in time with the current sequence as it plays
back. The Recorder’s event list will fill with events
as the notes you play on the Genos are captured.

performance so that its first event starts at bar 0;
•

right-click on the Recorder’s event list to edit the
selected events. Options include:

8. When you have finished recording, disable the
Recorder's Power button.

o select all of the events. (To select/deselect
individual events, control-click on them);

9. Click on the Transport’s Play button to stop
playback.

o move the selected events forwards or
backwards one division;
Important: Due to latency, it may be
necessary to move a captured
performance (or only certain events)
backwards one (or more) divisions in order
to sync them with the current sequence.

After capturing a Genos live performance, perform all
or some of the following actions as desired:
•

play back the captured performance and current
sequence;

•

if you are not happy with the captured
performance, click on the Clear button to delete
it and begin again;

o quantize the selected events. Choose 1/8,
1/4, or 1/1 to respectively quantize by
eighth notes, quarter notes, or whole
notes;

When capturing a performance, consider slowly
down the tempo (in both Genosys and on the
Genos) in order to improve the timing and accuracy
of captured performances.
•

o change the playback voice of the selected
events;
o set the velocity of the selected events to
the value of the Velocity slider on the
Keyboard Console;

click on the Trim button to trim the captured
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o set the length of the selected events to the
value of the Length indicator (top-right of
the window);
o delete the selected events.

Menu Option

Once you are happy with a captured performance,
move it to the current sequence (where it can be further
edited) by clicking on the Move to Sequence button.

Function

Genosys Menu

Genosys records L, R1, R2, and R3 note events that are
performed on the Genos.
For the R1 voice, Genosys also records pitch wheel
changes, mod wheel changes (positive), and sustain
pedal on/off.
In the Event List, the playback channels to which events
are assigned can be changed to L, R1, R2, R3, C5, C6,
C7, C8, C9, C10, C11, and C12.

About Genosys...

Opens the registration
window

Preferences...

Opens the Preferences
window

Quit Genosys

Closes the Genosys
application
File Menu

New Song...

Opens a dialog box for
choosing the save
location for a new song

Open Song...

Opens a dialog box for
choosing a song to open

Menu Options
Below is a list of the menu options in Genosys and their
respective functions:

16

sonicimmersion.com
Close
Backup Song...

Closes the song and quits
Genosys

in the Locator)

Opens a dialog box for
choosing a save location
in which to back up the
song

Select All

Selects all of the events in
the Event List

Expand Song

When viewing the main
“Song” sequence,
displays in the Event List
all of the events for the
sequences that have
been inserted into the
"Song" sequence

Delete Events...

Permanently deletes the
selected events in the
Event List

Song Comments...

Opens the Song
Comments window
where comments about
the song can be stored

Edit Menu
Cut

Moves the selected
events in the Event List to
the Genosys clipboard

Copy

Copies the selected
events in the Event List to
the Genosys clipboard

Paste

Pastes the events from
the Genosys clipboard to
the current sequence

Paste at Current Time

Pastes the events from
the Genosys clipboard to
the current sequence at
the current time (as noted

Transport Menu

17

Play

Plays the sequence

Record

Enables step recording.
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from the "Genosys" menu. Preferences are stored with
the current song.

Use the Keyboard
Console and Style
Console to insert events
into the sequence
Rewind

Goes to the beginning of
the sequence

Previous Marker

Goes to the previous
marker in the sequence

Next Marker

Show Warnings
Specifies whether alert dialogs are displayed when
deleting events, among other actions.
Font Size
Sets the font size of the Event List and Recorder’s event
list. Choose between a 12 and 14-point font size.

Goes to the next marker
in the sequence

Display Accidentals As
Specifies whether the accidental keys on the Keyboard
Console are displayed as sharps or flats. Choose the
setting which matches the key of the current song.

Insert Menu
[Various menu items]

Inserts a style command,
style volume event, or
note volume event into
the sequence at the
current time

On Stop Playback
Specifies what action to take when play back is
stopped. "No Action" does nothing. "Sync Start" sends
a "Sync Start" style command to the Genos. "Reg 1"
resets the Genos to Registration 1. "Sync Start + Reg 1"
issues both commands to the Genos.

Preferences Window

When composing a song using Genosys, use
Registration 1 as the 'working registration' to which you

To open the Preferences window, select "Preferences"
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can reset the Genos when playback is stopped.
For example, store the initial settings for your song in
Registration 2 and the settings for the chorus in
Registration 3 etc.
When you wish to work on the chorus section of your
song, select Registration 3 and then save the recalled
settings to Registration 1.
If you place a marker event at the beginning of the
chorus in Genosys, stopping playback of the chorus by
clicking on the Previous Marker button (on the
Transport) will reset the Genos according to the
preferences set for "On Stop Playback." The current
song position will also move to the beginning of the
chorus.
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Chapter 3. The Event
List
The Event List lists the individual events in the current
sequence ordered by bar:beat:division position. During
playback, the Event List scrolls through the events in the
sequence, highlighting each event as it is played back.

Inserting Events
When the Record button on the Transport is enabled,
events can be inserted into the Event List via the "Insert"
menu, the Style Console, the Keyboard Console, the
Timeline, and the Recorder as follows:
Event
Style
Chords
Style
Commands
Multi Pads
Style
Volumes
Event

Insert
Menu

Style
Console

Keyboard
Console

•

Timeline

•

•

•

•

•

•

•

Insert
Menu

Style
Console

Keyboard
Console

Timeline

•

Note
Chords
Note
Volumes
Pitch Bend

•

•

•
•

Modulation

•

Sustain

•

Sequences

•

Markers

•

Copying, Moving, Duplicating,
and Deleting Events
Choose options from the "Edit" menu to cut and copy
selected events to the Genosys clipboard and paste
events from the Genosys clipboard to the current
sequence, optionally beginning at the current time.

Recorder

•

•

Notes

For example, to move a group events from one
sequence to another:
1. Select the events to move.

Recorder
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2. Choose "Cut" from the "Edit" menu.

are described below.

3. Navigate to the sequence you wish to move the
events to.

Mute

4. Choose "Paste" from the "Edit" menu.

Mutes an event so that it does not playback. Right-click
on the "Mute" column to mute/unmute the selected
events.

Or duplicate a chord progression in order to repeat it:
1. Select the chord progression events to
duplicate.

Position

2. Choose "Copy" from the "Edit" menu.

The position (i.e., bar:beat:division) of the event in the
sequence. Right-click on the "Position" column to:

3. Change the current time (using the Locator) to
the starting bar:beat:division position at which
the events should be duplicated.

•

set the current position (as displayed in the
Locator) to the position of the selected event;

•

set the position of the selected events to the
current position;

Editing Events

•

move the selected events forward or backward
one bar;

In the Event List, right-click on the column of an event to
edit it, as well as any other events that are selected.

•

move the selected events forward or backward
one division;

The editing options for each of the Event List columns

•

trim the selected events so that the first selected

4. Choose "Paste at Current Time" from the "Edit"
menu.
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event starts at bar 0.

Sequence
The sequence the event belongs to. This column is only
displayed if the "Expand Song" option is enabled in the
"Edit" menu. It cannot be edited.
When viewing the main “Song” sequence, choose
“Expand Song” from the "Edit" menu to show all of the
events for the sequences that have been inserted into
the song. As each event is played back, it is highlighted
in the Event List.

•

markers

•

style chords (e.g., C3 E3 G3)

•

style commands (e.g., Main A, Multi Pad 1)

•

notes (e.g., Note R1)

•

note chords (e.g., Chord R1)

•

note volumes

•

pitch bend (e.g., Pitch R1)

•

modulation (e.g., Mod+ R1)

•

sustain (e.g., Sustain R1)

Values

The type of event. Genosys supports the following
event types:
sequences

style volumes

For certain event types, right-click on the "Event"
column to change the event type of the selected events
(e.g., change Note R1 to Note R2).

Event

•

•

The values of the event. Each event type has a different
set of value properties that are listed in up to three
columns in the Event List. For example, a note event
may have the following values:
G4 | 100 | 000:1:00
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In the above example, "G4" is the note value, "100" is
the note velocity, and "000:1:00" is the note length (i.e.,
one beat).

length of the selected note events to the value of
the Length indicator (top-right of the window).

Filtering Events

When you select an event in the Event List, the
headings of the value columns change to indicate the
value properties for that event. For example:

The Event List can be filtered to only display those
events which match specific criteria.

Note | Velocity | Length

Right-click on the "Event" column to only display and
play back those events which match a specific event
type (e.g., Note R1).

For certain event types, right-click on a value column to
change the values of the selected events. For example:
•

right-click on the "Command" column to set the
style command of the selected style events;

•

right-click on the "Style Chord" column to set the
chord of the selected style chord events;

•

right-click on the "Note" column to set the note
and octave of the selected note events;

•

right-click on the "Velocity" column to set the
velocity of the selected note events to the value
of the Velocity slider on the Keyboard Console;

•

right-click on the "Length" column to set the

Right-click on the "Location" column to only display and
play back those events which match a specific bar, beat,
or division position (e.g., ###:3:##).
Filter the Event List in order to more easily edit similar
events. For example, to mute all of the Note R3 events
in a sequence which contains a mix of Note R1, Note
R2, and Note R3 events, right-click on the "Event"
column of a Note R3 event and choose "Filter: Note
R3." Only the Note R3 events will be displayed in the
Event List. Choose "Select All" from the "Edit" menu to
select all of the events. Then right-click on the "Mute"
column of an event to mute all of the events.
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To reset the event filter and display all of the events in
the sequence, click on the "Filter:" display which is
located above the Event List on the right.

Toggling Sequence Voices
You can toggle the play back of the note, note chord,
volume, modulation, pitch, and sustain events which are
assigned to individual voice channels in a sequence.
Right-click on the "Voices" column of a sequence event
to toggle the play back of the events assigned to each
of the twelve voice channels.
Voice channels which are preceded with a bullet (i.e., •)
play back their events, while those which are preceded
with a dash (i.e., -) do not.
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Chapter 4. The
Keyboard and Style
Consoles

(commonly known as "all notes off"), press the ! button
on the Keyboard Console.

The Keyboard Console and the Style Console are used
to control the Genos keyboard remotely and insert
events into the current sequence.

To insert a note into the current sequence, set the
Locator to the position where the note is to be inserted.
Enable the Record button on the Transport. Then press
a note key. The note will be inserted into the sequence
at the current time position.

Inserting Notes into the Current
Sequence

Keyboard Console

The current time position will then move forward by the
length of time specified by the Offset indicator (topright of the window). Click on a note key to insert
another note at the new time position.

The Keyboard Console is a two-octave virtual keyboard
which is used to play (on the Genos) and insert (into the
current sequence) notes, note chords, and style chords.

To insert a rest, press the [] note key. No note event will
be inserted, but the current time position will move
forward.

Playing Notes on the Genos
To play a note on the Genos, ensure that the Genos is
connected. Then enable the Power button (below the
"Voice" label) on the Keyboard Console. Press a note
key.

On the Keyboard Console, the Velocity Slider specifies
the velocity for inserted/played notes. The Length
indicator (top-right of the window) sets the length for
inserted/played notes.

To send a reset all channels command to the Genos

25

sonicimmersion.com
Toggle the voice buttons on and off (e.g., L, R1, R2,
and R3) to specify the voice(s) for the notes that are
inserted/played.

individual voice assignment on the Genos.
Press the A1, A2, and A3 buttons on the Keyboard
Console to insert/play a R1 articulation. (Articulations
are only enabled for certain Genos voices. Refer to the
Genos documentation for details.)

Composing 12 Channel Songs
The C5 to C12 voice buttons correspond to the style
channels which can also be used to play back notes
(normally when the style engine is disabled on the
Genos). The style channels are set up as following:
C5
C6
C7
C8
C9
C10
C11
C12

Press the + or - buttons to shift the virtual keyboard up
or down an octave.
Choose "Preferences..." from the "Genosys" menu to
specify whether the accidental notes on the virtual
keyboard are displayed as sharps or flats.

Rhythm 1
Rhythm 2
Bass
Chord 1
Chord 2
Pad
Phrase 1
Phrase 2

Inserting Chords
The Keyboard Console can be used to insert chord
styles into the current sequence. Chord styles work with
the Genos' style engine, allowing complex backing
arrangements to be composed.

On the Genos, navigate to the Mixer page to set the
voice for each style channel.

To insert a chord style into the current sequence:

When the Genos' style engine is disabled, Genosys can
be used to compose and play back 12-channel
compositions on the Genos, using the L, R1, R2, R3, and
C5 through C12 channels, each of which has its own

1. Set the Locator to the position where the chord
style event is to be inserted.
2. Enable the Record button on the Transport.
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Style Console

3. Press the Style button on the Keyboard Console.
4. Toggle the Insert Chord button on.

The Style Console is used to send style commands to
the Genos and to insert style events into the current
sequence.

5. One at a time, press the note keys which will
make up the chord (e.g., C, E, and G). Each will
be highlighted.

The style commands include:

6. Toggle the Insert Chord button off.
7. The chord style will be inserted into the
sequence at the current time position.
8. The current time position will move forward by
the length of time specified by the Offset
indicator.
9. Repeat the above steps to insert another chord
style into the current sequence, creating a chord
progression.
In addition to inserting chord styles, you can also insert
note chords into the current sequence. For Step 3
above, toggle the voice buttons on and off to specify
the voice(s) for the chords that are inserted. This feature
can be especially useful for songs which are choral in
nature.

27

•

Start/Stop: Starts or stops style playback on the
Genos;

•

Sync Start: Starts style playback when the next
chord style event is received by the Genos;

•

Registration 1: Recalls Registration 1, allowing
you to reset a Genosys song to its default style
settings;

•

Intro 1 / Intro 2 / Intro 3: Triggers a style intro;

•

Main A / Main B / Main C / Main D: Triggers a
main style;

•

Fill Up: Triggers the next main style, inserting a
fill;

•

Fill Self: Inserts a fill;
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•

Fill Down: Triggers the previous main style,
inserting a fill;

•

Break: Inserts a break;

•

Ending 1 / Ending 2 / Ending 3: Triggers a style
ending;

•

Fade In/Out: Fades the song in or out;

•

OTS 1 / 2 / 3 / 4: Switches between one touch
settings;

•

P1 / P2 / P3: Triggers a multi pad;

•

n: Stops multi pad playback.

Inserting Style Commands into the
Current Sequence
To insert a style command into the current sequence,
set the Locator to the position where the style
command is to be inserted. Enable the Record button
on the Transport. Then press a style command button.
The style command will be inserted into the sequence
at the current time position.
The current time position will then move forward by the
length of time specified by the Offset indicator. Click on
another style command to insert another event at the
new time position.

For more information about each of the above style
commands, refer to the Genos documentation.

Turning Style Channels On and Off

Sending Style Commands to the Genos

The Style Console can be used to turn style channels on
and off using volume events.
For example, you could compose a song which begins
with only a small subset of the style channels turned on
(e.g., Rhythm 1, Bass, and Pad). Each of the remaining
style channels is then turned on in subsequent bars,
building up the song over time.

To send a style command to the Genos, ensure that the
Genos is connected. Then enable the Power button
(top-left corner of the Style Console). Press a style
command button.
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To insert a style channel volume event into the current
sequence:
1. Set the Locator to the position where the style
channel volume event is to be inserted.
2. Enable the Record button on the Transport.
3. Set the Vol slider on the Style Console. To turn a
style channel “off,” set the Vol slider to 0. To turn
a style channel “on,” set the Vol slider to a value
higher than 0.
4. On the Style Console, press one of the R1, R2,
BS, C1, C2, PD, P1, or P2 style channel buttons
to insert a style channel volume event into the
sequence at the current time position.
5. The current time position will move forward by
the length of time specified by the Offset
indicator. (Set the Offset indicator to 000:0:00 to
insert multiple events at the same time position.)
6. Repeat the above steps to insert another style
channel volume event into the current sequence.
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Chapter 5. The
Timeline

•

copy event(s) to the Genosys clipboard;

•

cut (i.e., move) event(s) to the Genosys
clipboard;

The Timeline visually arranges the marker, style
command, style chord, and multi pad events in the
current sequence running left to right along a timeline.
During playback, the Timeline scrolls through the
events in the current sequence, highlighting the current
bar.

•

paste event(s) from the Genosys clipboard;

•

select an event in the Event List.

Markers
New markers can be named and inserted into the
"Markers" row.

Click on the – and + buttons at the bottom-left of the
Timeline to narrow or widen the width of the cells in the
Timeline. Wider cells display more text in each cell.
Narrower cells display more bars.

Style Chords
Style chords that have been inserted into the Event List
using the Keyboard Console can be inserted into the
"Chords" row, creating style chord progressions.

Editing the Timeline
Click on a timeline cell to:
•

•

Style and Multi Pad Commands

insert a new event into the current sequence at
the current bar:beat location (as noted in the top
row of the Timeline);

The following events can be inserted into the “Style”
row of the Timeline. Each has a short acronym which is
displayed in the Timeline cell the event is inserted into:

replace an existing event with a new event;
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•

Main A (A)

•

Start/Stop (S/S)

•

Main B (B)

•

Sync Start (STA)

•

Main C (C)

•

Registration 1 (REG1)

•

Main D (D)

•

Intro 1 (IN1)

•

Fill Up (FU)

•

Intro 2 (IN2)

•

Fill Self (FS)

•

Intro 3 (IN3)

•

Fill Down (FD)

•

Ending 1 (END1)

•

Break (BRK)

•

Ending 2 (END2)

•

OTS 1 (OTS1)

•

Ending 3 (END3)

•

OTS 2 (OTS2)

•

Fade In/Out (FADE)

•

OTS 3 (OTS3)

•

OTS 4 (OTS4)

The following events can be inserted into the “Multi
Pads” row of the Timeline:

•

Articulation 1 (ART1)

•

Articulation 1 (ART2)

•

Articulation 1 (ART3)
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•

Multi Pad 1 (PAD1)

•

Multi Pad 2 (PAD2)

•

Multi Pad 3 (PAD3)

•

Multi Pad 4 (PAD4)
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•

scroll through the 50 bars that are currently in view.

Multi Pad Stop (PADS)

To change the bar range that is displayed (e.g., from “0
– 50” to “51 – 100”), click on the top-left cell of the
Timeline.

Sequence Layers
When viewing the “Song” sequence, the Timeline also
displays the sequences that have been inserted into the
song. Sequences can be assigned to any of twelve
sequence layers, allowing multiple sequences to be
layered on top of one another, building up the
arrangement of a song.

Click on a bar:beat cell along the top row of the
Timeline to set the Locator to the bar:beat position.

Resize the window and drag the divider which
separates the Timeline and Event List to increase the
height of the Timeline, displaying more sequence
layers.
The Timeline’s twelve sequence layers can be renamed
(e.g., Piano, Guitar, Strings etc.). Click on the name of a
sequence layer (at the far left of the Timeline).

Navigating the Timeline
The Timeline displays 50 bars at a time. Use the
horizontal scroll bar at the bottom of the Timeline to
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